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A

Legal notice



Copyright and trademark information relating to this product release.

Copyright © 2000–2024 RWS Holdings plc. All rights reserved.

This legal notice applies to RWS Holdings plc and its subsidiaries and affiliates. All intellectual
property rights contained herein are the sole and exclusive rights of RWS. All references to
RWS shall mean RWS Holdings plc and its subsidiaries and affiliates details of which can be
obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by RWS. Except as otherwise expressly permitted hereunder
or in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of RWS.

MultiTerm is a registered trademark of RWS. All other trademarks are the property of their
respective owners. The names of other companies and products mentioned herein may be
the trademarks of their respective owners. Unless stated to the contrary, no association with
any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ” on page 19 .

Although RWS takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or
damage of any kind or arising out of, or in connection with, the use or performance of the
Software Documentation even if such losses and/or damages were foreseen, foreseeable or
known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of
business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or
consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." RWS makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of RWS.
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About MultiTerm



About this guide
Welcome to the MultiTerm 2024 Installation Guide. This guide provides instructions for
installing and configuring MultiTerm 2024.

Intended audience
This guide contains information for whoever is responsible for installing and maintaining
MultiTerm (usually the MultiTerm administrator).

You are assumed to be familiar with standard Windows administration practices, such as
managing a Windows user account.

Related documentation
• MultiTerm Extract Tools Guide - A user guide for the terminology extraction tool -

MultiTerm Extract.

• Trados GroupShare 2020 Installation Guide  - for those installing MultiTerm in a
multi-user environment.

Accessing RWS documentation
You can check the help for all Translation Productivity products on the Documentation
Center .

About MultiTerm
Local and remote termbases
MultiTerm Desktop is a scalable solution that can be used in single-user or multi-user setups.
In a single-user setup, termbases are stored on the local computer. In a multi-user setup,
termbases are stored on a remote database server and accessed over the network.

Data storage
MultiTerm uses Microsoft Jet to store termbase data locally and Microsoft SQL Server (or
SQL Server Express) to store termbase data remotely.

1 About MultiTerm
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MultiTerm XML data format
MultiTerm termbase data is stored in an XML format, MultiTerm XML (MTF.XML). Other
termbase elements, such as the termbase definition and objects are also XML compliant.
The use of XML enables quick and easy exchange of data between users.

Language support
MultiTerm Desktop is Unicode-compliant and therefore supports a wide range of languages,
including bi-directional and double-byte character set languages. For example, termbase
fields can include a mixture of languages.

Note that to use non-Western languages, the relevant language support must be installed
on your computer.

Note:

• If you want compatibility across different language, enter the names of termbase
definitions and termbase objects in ASCII.

MultiTerm Interface with Trados Studio
Trados Studio includes its own MultiTerm interface, so you can use MultiTerm termbases
from Trados Studio without installing MultiTerm Desktop.

Editions of MultiTerm
MultiTerm is shipped in four editions:

• MultiTerm Desktop ( MultiTerm, MultiTerm Convert, MultiTerm Widget)

• MultiTerm Widget

• MultiTerm Server

MultiTerm Desktop
MultiTerm Desktop is the MultiTerm edition that is installed on the desktop. It can use local
termbases and can also use remote termbases that are managed by MultiTerm Server.

MultiTerm Desktop includes MultiTerm Convert and MultiTerm Widget.

This guide describes the installation of MultiTerm Desktop.

1About MultiTerm
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MultiTerm Widget
MultiTerm Widget is a simple application that captures text from your screen and finds
definitions in MultiTerm termbases, or by using Internet search engines.

MultiTerm Server
MultiTerm Server is the server component for corporate and enterprise customers as well
as language service providers (LSPs).

Termbases and associated data are usually stored in a Microsoft SQL Server, but you can use
Microsoft SQL Server Express.

MultiTerm Desktop components

MultiTerm Desktop
You can use MultiTerm to access termbase data stored on the local computer, and also as a
client to access termbases managed by MultiTerm Server.

Access to termbases stored on MultiTerm Server can be restricted by the MultiTerm Server
administrator.

MultiTerm Desktop also includes the following components:

• “MultiTerm Widget ”  on page 4

• “MultiTerm Convert ”  on page 5

MultiTerm Extract is now a standalone product that you can download from the RWS
AppStore .

MultiTerm Widget
MultiTerm Widget can be installed as a component of MultiTerm. It can also be installed on
its own.

MultiTerm Widget captures text from your screen and finds definitions in MultiTerm
termbases or by using Internet search engines.

1 About MultiTerm
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MultiTerm Convert
MultiTerm Convert is a stand-alone tool that converts terminology data to MultiTerm XML
format. It can convert data that is in the following formats:

File type File name extension

Trados MultiTerm 5 .mtw

MultiTerm Desktop .tdb

MultiTerm Online .mdb

OLIF (Open Lexicon Interchange
Format)

.xml

Microsoft Excel .xls

.xlsx

Spreadsheet and Database
Exchange

.txt

.csv

Termbase Exchange (Termbase
eXchange Format)

.tbx

.xml

You can also purchase an extra MultiTerm component separately.

1About MultiTerm
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Installing MultiTerm Desktop



System Requirements

Hardware
As a minimum requirement, we recommend an Intel or compatible CPU-based computer
with 2 GB RAM and a screen resolution of 1024x768. For optimum performance, we
recommend 4 GB RAM and a recent Intel or compatible CPU.

Supported Operating Systems (OS)
• MultiTerm 2024 runs on the latest build of Windows 11, Windows 10 and the latest

updated version of Windows 8.1 and the latest service-packed version of Windows 7.
MultiTerm 2024 also supports Windows Server 2016, Windows Server 2012 R2 and
Windows Server 2008 R2.

• Limited support for Windows 7. Microsoft has stopped support for Windows 7. As a
result, we are no longer testing MultiTerm on Windows 7. However, MultiTerm continues
to work on Windows 7 as we have not made any changes that could affect the MultiTerm
functionality on this operating system.

• MultiTerm 2024 does not support earlier operating systems such as Windows 8, Windows
Vista, Windows XP and Windows 2003 Server.

Installing MultiTerm Desktop

Before you start
If you intend to use termbases that have been created in previous versions of MultiTerm,
review “Upgrading from Previous MultiTerm Installations ” on page 12.

Ensure that you have administrator rights.

Third-party software
MultiTerm needs the following third party applications. It will install them if they are not
already installed:

• Microsoft .NET Framework version 4.8. In some cases, installing this requires a reboot.
This is usually installed by the bootstrapper that runs prior to the MultiTerm client
installer. It is also available from the Microsoft website.

• Microsoft Visual C++ 2022 Redistributable. This is usually installed by the MultiTerm
client installer. When running the MultiTerm client installer, it is unpacked to
%ProgramData%\Package Cache\Trados\Dependencies\2022_vcredist_x86.exe.

2 Installing MultiTerm Desktop
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If a previous version of this C++ runtime is installed, Windows Update will install the
new version automatically.

Installation locations
The installation working files are extracted to the folder: %ALLUSERSPROFILE%\Package
Cache\Trados\MultiTermDesktop2022SR1

By default, the installer installs MultiTerm under:

• For 32-bit Windows - %programfiles%\Trados\MultiTerm\MultiTerm18

• For 64-bit Windows - %programfiles(x86)%\Trados\MultiTerm\MultiTerm18

The Program Files folder on your computer may have a different name if you are using a
non-English operating system.

MultiTerm 2024 does not uninstall any previous versions of MultiTerm.

Installation log files
The installer logs significant actions to a log file.

• The log file for Windows 2003 is in: %ALLUSERSPROFILE%\Application Data\Trados
\Chainer\Logs.

• The log file for Windows Vista and later is in: %ALLUSERSPROFILE%\ Trados\ Chainer\ Logs.

Note: By default, Windows sets the %ALLUSERSPROFILE% folder to be hidden, so you may
need to change the Windows Explorer settings to find it.

Installing MultiTerm Desktop
Procedure
1. Go to My Account .
2. Select Products & Plans > Downloads on the website.
3. Select Download next to MultiTerm 2024 Desktop Installer. Run the installer to unpack

the installation files and start the installation.
4. The MultiTerm Desktop Installer displays the End-User License Agreement. If you accept

the terms, select Next.
5. On the next screen, choose the components to install and select Next. When you select

the component, a description is displayed.
6. Choose an installation location. We recommend that you install to the default location.

Avoid installing to the same directory used for any previous versions of MultiTerm. Select
Next.

7. Review your selection of components. Select Back to change any options. Select Next
to proceed with the installation.

2Installing MultiTerm Desktop
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8. The MultiTerm installer now installs the MultiTerm Desktop components.
9. If you are upgrading from a version of MultiTerm older than MultiTerm 2009, the old

termbases are moved to another folder, and a screen displays this fact. Select OK.
10. When the components are installed, the final screen is displayed. Select OK.

If you installed the MultiTerm Desktop Applications for Microsoft Word, the MultiTerm
tab is added to the Word ribbon the next time you run Word.
You can use the MultiTerm tab to access termbases and work with termbases data
from Word.

Installing and uninstalling silently

Preparing for silent installation - extract product
installers
Extract the installation files for the RWS products and the third-party software.

About this task
To do this, run the installer until the compressed files are all decompressed and extracted,
and then before the installation takes place, stop the installer. The package containing the
files is a self-extracting executable and can be decompressed with any decompressing utility
that works with the .rar compression format.

The unpack location is:

%ALLUSERSPROFILE%\Package Cache\Trados\MultiTermDesktop2024

About msiexec command-line options
Where the msiexec command is mentioned in the procedures described below, it is usually
with command line options such as /q or /l*x. You can use different options. For more
information about the command-line options for the msiexec command, see the website
msdn.microsoft.com .

Installing the third-party software products

2 Installing MultiTerm Desktop
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About this task
See also section Third-party software, above.

• Microsoft Windows Installer 3.1. This is not included in the Studio distribution package.
The command line to silently install is :

<path to package> /quiet /norestart /log:<path to log file>

• Microsoft .NET Framework version 4.8. You can find this on the Microsoft web site here .

• Microsoft Visual C++ 2022 Redistributable with MFC update Command line to silently
install:

<Path to dir>\2022_vcredist_x86.exe" /q /norestart /log "<path to log
file>"

This command may return an MSI error code if Visual C++ 2022 Redistributable is already
installed.

Installing MultiTerm components
About this task
Typically, a silent installation will run automatically. If not, manually install the .msi files
available in the following location: %ALLUSERSPROFILE%\Package Cache\Trados
\MultiTermDesktop2024\modules.

Procedure
1. Click Start > Run and run the following command to install the two components

required for MultiTerm Desktop:

•
msiexec.exe /i "<path to MTStudio17.msi file" /qn /l*v "<path to
log file>.

•
msiexec.exe /i "<path to MTCore17.msi" /qn /l*v "<path to
log file>.

2. Run the command again for any optional MultiTerm components that you require:

• MTConvert17.msi

• MTExtract17.msi

• MTWidget17.msi

2Installing MultiTerm Desktop
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Example set of commands to install a number
of Trados products
Command line properties used in the msiexec command.

INSTALLDIR. You can change the installation path for any of the Trados products by changing
the value of INSTALLDIR, but this is not recommended.

CLIENTINSTALL. Set this to 1 for the MT17Core.msi. If you set this to zero (0) the product will
have no start menu entry and no working autoupdate.

The commands

set INSTALL_DIRECTORY=%ProgramFiles%\Trados\MultiTerm\MultiTerm18

set LOG_DIRECTORY=%ALLUSERSPROFILE%\Trados\Chainer\Logs

(For Windows 7 and Windows 8.1 and Windows 10)

set LOG_DIRECTORY=%ALLUSERSPROFILE%\Application Data\Trados\Chainer\Logs

Uninstalling
To silently remove an MSI, use the following command:

msiexec /x "<path to msi file>"/qn

Note: Do not silently remove all msi modules that have been installed by the installer.
Otherwise you will not be able to use the Remove suite of products entry from the Control
Panel programs list.

Upgrading from previous MultiTerm
Installations

2 Installing MultiTerm Desktop
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Overview of the Upgrade Process
Before you upgrade, take a copy of all termbases and termbase objects.

Install MultiTerm 2024 as described in Installing MultiTerm.

Software compatibility: previous versions
You can install MultiTerm 2024 alongside MultiTerm 2022 SR2 and run them simultaneously.

Note that you can install any version of MultiTerm Widget on the same computer. RWS
strongly recommends that you use the latest version.

MultiTerm Desktop can work with MultiTerm Server included with Trados GroupShare 2020
and Trados GroupShare 2017. Trados GroupShare 2015 is no longer supported.

Termbase and termbase object compatibility

Local termbases
MultiTerm 2007, MultiTerm 2009 and iX termbases are upgraded automatically when you
open them in MultiTerm 2024. MultiTerm 2011 and 2014, 2017, 2019 termbases can be used
without conversion.

However, you can continue to use older termbases in MultiTerm 2024. To do this, convert
them to MultiTerm XML format using MultiTerm Convert.

MultiTerm 2024 does not allow you to add terms which are longer than 1023 characters.
Terms imported from MultiTerm '95 or MultiTerm 5 which are longer than 1023 characters
may give faulty search results.

If you have a termbase created in MultiTerm version 5.5 or earlier, run MultiTerm Convert.
MultiTerm Convert produces a termbase definition (XDT) file, which describes the structure of
the terminology data. Use this XDT file to create an empty termbase, and import the
converted data into that termbase.

Termbase objects
Termbase objects include filters, layouts, input models, export and import definitions.

Termbase objects cannot be migrated from MultiTerm '95 Plus or MultiTerm 5.x to MultiTerm
2024. After you have migrated the terminological data to MultiTerm 2024, create the
termbase objects manually.

File-based termbases created in MultiTerm 6.x to MultiTerm 2007 can be opened directly in
MultiTerm 2024 Desktop. Server-based termbases created in MultiTerm 6.x to MultiTerm
2007 have to be upgraded. The upgrade process is described in the Trados GroupShare
Installation Guide . For more information see the topic "Using SDL MultiTerm 2007

2Installing MultiTerm Desktop
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Termbases" in the MultiTerm 2024 Help .

To save termbase objects from later versions of MultiTerm, select Save (in the Catalog
view), and then load them into MultiTerm 2024.

Default locations for MultiTerm installations
The default installation locations for previous versions of MultiTerm are as follows.

MultiTerm Desktop version 17:

%ProgramFiles%\Trados\MultiTerm\MultiTerm17

MultiTerm Desktop version 16:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm16

MultiTerm Desktop version 15:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm15

MultiTerm Desktop version 14:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm14

MultiTerm Desktop version 12:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm12

MultiTerm Desktop version 11:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm11

MultiTerm Desktop version 9:

%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm9

MultiTerm Desktop version 8:

%ProgramFiles%\SDL\SDL MultiTerm\8

MultiTerm Desktop version 7.5:

%ProgramFiles%\SDL International\SDL MultiTerm 2007

MultiTerm Desktop version 7.0 and 7.1:

%ProgramFiles%\TRADOS\

MultiTerm Workstation version 6.2:

%ProgramFiles%\TRADOS\MTiX\

MultiTerm Workstation version 6.0:

%ProgramFiles%\TRADOS\Corporate Language\

2 Installing MultiTerm Desktop
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Uninstalling MultiTerm
Uninstalling MultiTerm Desktop removes all the MultiTerm program files, folders and registry
entries but retains all the data files and folders, including the termbase files, associated
termbase data, and saved object definitions.

Procedure
1. You uninstall via Start > Control Panel > Programs > Uninstall a program or

Programs and Features. Choose Uninstall or Remove, as appropriate.
2. Select MultiTerm 2024 - Remove suite of products.
3. Select the components you want to uninstall and select Next.
4. An information box is displayed. It is updated automatically as the removal proceeds.
5. When the selected components have been removed, a confirmation dialog box is

displayed.
6. Select OK.

Software updates

Temporary directory
Software updates are downloaded to the following temporary directory:

%temp%\multiterm18Updates

After the update is installed, you can delete this directory.

Software update log files
MultiTerm Desktop creates a file that logs the checking for updates and the downloading of
the installer for the update. This log file is in:

%ALLUSERSPROFILE%\Trados\MultiTerm\MultiTerm18\Updates

Another log file is created during the update. You can find it in:

%temp%\multiterm18Updates

2Installing MultiTerm Desktop

15Installation Guide



Individual user software updates
By default, as a MultiTerm user, you can do the following:

Procedure
1. Specify that MultiTerm Desktop checks for software updates when it starts. To do this,

select File > Options > Automatic Updates.
2. Manually check for updates. To do this, select Help > Check for Updates.
3. Check for updates via Start > MultiTerm 2024 > Check for updates

The system administrator can enable or disable checking for software updates, so these
options may not always be available.

Change the notification policy for updates
By default, MultiTerm Desktop notifies users when a software update is available, and also
gives users the option to install updates. As an administrator, you can change these settings.

About this task
To change these options, define a group policy, as follows:

Procedure
1. Select Start > Run and enter the command: gpedit.msc

The Group Policy dialog box is displayed.
2. Right-click Computer Configuration > Administrative Templates and select

Add/Remove Templates from the shortcut menu.
The Add/Remove Templates dialog box is displayed.

3. Select Add and browse to the MultiTermAutoUpdate. adm file.
The default location for this file is:
\ProgramData\Package Cache\Trados\MultiTermDesktop2022SR1

4. Classic Administrative Templates (ADM) > SDL Applications > SDL MultiTerm v1 is
added to the navigation tree. Select this to display its settings on the right.

5. Double-click Enable Auto-update.
6. The Enable Autoupdate Properties dialog box is displayed on the Setting tab. Choose

one of the following options and select OK.

• Not Configured - The user can choose to enable or disable automatic checking for
application updates and can also manually check for application updates.

• Enabled - MultiTerm Desktop checks for updates automatically. The user cannot
disable the automatic updates option. The user can also manually check for
application updates.

• Disabled - Automatic and manual checks for updates are both disabled. The user
cannot enable these options.

2 Installing MultiTerm Desktop
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Remove your software update
Procedure
1. In the Windows Control Panel, select Add or Remove Programs or Programs and

Features.
2. To see the software updates, select View Installed Updates.
3. Select the software update and select Remove/ Uninstall.
4. Follow the on screen instructions.

If you don't want to automatically check for updates, clear the check box Automatically
check for updates when the application starts under Options > Automatic Updates.

Digital certificate requirements
All MultiTerm Desktop code and installer files are digitally signed. Make sure your list of
approved root certificates is up-to-date and includes the root certificate from the Certification
Authority that generates MultiTerm Desktop's code signing certificate. At the time of writing,
Trados Studio require DigiCert Assured ID Root CA and DigiCert Assured ID Code Signing
CA-1.

• For computers with access to the Internet, go to https://www.digicert.com and add the
new root certificate to your Trusted Root Certification Authorities certificate store. This
is only available for computers running on operating systems supported by Microsoft
(Windows Vista or later).

• For computers in a locked down corporate environment without access to the Internet,
follow the instructions available at https://technet.microsoft.com/library/dn265983.aspx .

You can also download the specific root certificates directly from
https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to each
locked down workstation manually or by group policy.
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MultiTerm includes open source or similar third-party software.

Autofac
Version: 4.8.1

Vendor: Autofac

Copyright: Copyright © 2015 Autofac Contributors

License type: MIT

License details: “https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE”  on page 0

Azure.Core
Version: 1.38.0

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

Azure.Identity
Version: 1.11.1

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

CachedImage
Version: 1.0.1

Vendor: Hari Pachuveetil

Copyright: MIT © Haridas Pachuveetil 2014

License type: MIT

License details: “https://github.com/floydpink/CachedImage/blob/main/LICENSE”  on
page 0

ControlzEx
Version: 4.4.0

Vendor: Jan Karger, Bastian Schmidt

Copyright: Copyright © 2015 - 2020 Jan Karger, Bastian Schmidt, James Willock

License type: MIT

License details: “https://github.com/ControlzEx/ControlzEx/blob/4.4.0/LICENSE”  on page
0
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Crc32.NET
Version: 1.2.0

Vendor: force

Copyright:

License type:

License details: “https://github.com/force-net/Crc32.NET/blob/develop/LICENSE”  on
page 0

DocumentFormat.OpenXml
Version: 2.15.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/OfficeDev/Open-XML-SDK/blob/v2.15.0/LICENSE”  on
page 0

Flee
Version: 1.2.2

Vendor: Muhammet Parlak

Copyright: Copyright 2017 Muhammet Parlak

License type: L-GPL

License details: “https://github.com/mparlak/Flee”  on page 0

HtmlAgilityPack
Version: 1.11.16

Vendor: ZZZ Projects

Copyright: Copyright © ZZZ Projects Inc.

License type: MIT

License details: “https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE”
 on page 0

Hunspellx86
Version: 1.7.2

Vendor: Crawler-Lib

Copyright: Copyright (C) 2002-2017 Németh László

License type: L-GPL

License details: “https://github.com/hunspell/hunspell/blob/v1.7.2/license.hunspell”  on
page 0
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ICSharpCode.Decompiler
Version: 7.1.0.6543

Vendor: Daniel Grunwald, Siegfried Pammer

Copyright: Copyright 2011-2021 AlphaSierraPapa

License type:

License details: “https://github.com/icsharpcode/ILSpy/blob/v7.1/doc/license.txt”  on
page 0

icu.net
Version: 2.9.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International

License type: MIT

License details: “https://github.com/sillsdev/icu-dotnet/blob/v2.9.0/LICENSE”  on page 0

Icu4c.Win.Full.Lib
Version: 59.1.15

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International

License type: ICU

License details: “https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE” 
on page 0

log4net
Version: 2.0.16

Vendor: Cincura.net, Apache.Logging

Copyright: Copyright 2004-2017 The Apache Software Foundation

License type: Apache 2.0

License details: “https://github.com/apache/logging-log4net/blob/rel/2.0.14/LICENSE”  on
page 0

MahApps.Metro
Version: 2.4.10

Vendor: Jan Karger, Dennis Daume

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.

License type: MIT

License details: “https://github.com/MahApps/MahApps.Metro/blob/2.4.10/LICENSE”  on
page 0
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Markdig.Signed
Version: 0.31.0

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel.All rights reserved.

License type: BSD-2-Clause

License details: “https://github.com/xoofx/markdig/blob/master/license.txt”  on page 0

MaterialDesignColors
Version: 3.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes
Version: 5.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes.MahApps
Version: 1.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/master/LICENSE”
 on page 0

Microsoft.ApplicationInsights
Version: 2.22.0

Vendor: Microsoft

Copyright: Copyright (c) 2015 Microsoft

License type: MIT

License details:
“https://github.com/microsoft/ApplicationInsights-dotnet/blob/v2.2.0/LICENSE”  on page
0
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Microsoft.AspNet.WebApi.Client
Version: 6.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details:
“https://www.nuget.org/packages/Microsoft.AspNet.WebApi.Client/6.0.0/License”  on
page 0

Microsoft.AspNetCore.Connections.Abstractions
Version: 8.0.3

Vendor: Microsoft, aspnetcore

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Client
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Common
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.JsonPatch
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MS-PL

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0
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Microsoft.AspNetCore.SignalR.Client
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Client.Core
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Common
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Protocols.Json
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Bcl.AsyncInterfaces
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0
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Microsoft.Bcl.HashCode
Version: 1.1.1.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/main/LICENSE.TXT”  on page 0

Microsoft.Bcl.TimeProvider
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.CSharp
Version: 4.7.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration.Abstraction
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0
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Microsoft.Extensions.Configuration.Binder
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.DependencyInjection
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyInjection.Abstractions
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyModel
Version: 7.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/core/blob/v7.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Features
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Extensions.Http
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging.Abstractions
Version: 8.0.1

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.Options
Version: 8.0.2

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.2/LICENSE.TXT”  on page 0

Microsoft.Extensions.Primitives
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Identity.Client
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0
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Microsoft.Identity.Client.Extensions.Msal
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0

Microsoft.Identity.Client.NativeInterop
Version: 0.16.0

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “”  on page 0

Microsoft.IdentityModel.Abstractions
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.JsonWebTokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.Logging
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0
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Microsoft.IdentityModel.Tokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.Office.Interop.Outlook
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Office.Interop.Word
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Web.WebView2
Version: 1.0.2210.55

Vendor: Microsoft, webview

Copyright: © Microsoft Corporation. All rights reserved.

License type:

License details:
“https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.2210.55/License”  on
page 0

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.77

Vendor: Microsoft, xamlexperiencesteam

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/microsoft/XamlBehaviorsWpf/blob/v1.1.77/LICENSE” 
on page 0
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murmurhash-signed
Version: 1.0.2

Vendor: Darren Kopp

Copyright: Copyright © 2021 The Apache Software Foundation, Licensed under the Apache
License, Version 2.0.

License type: Apache 2.0

License details:
“https://github.com/darrenkopp/murmurhash-net/blob/master/LICENSE.md”  on page 0

NETStandard.Library
Version: 2.0.3.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT”  on page
0

Newtonsoft.Json
Version: 13.0.3

Vendor: James Newton-King

Copyright: Copyright (c) 2007 James Newton-King

License type: MIT

License details:
“https://raw.githubusercontent.com/JamesNK/Newtonsoft.Json/master/LICENSE.md”  on
page 0

Nlog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen

Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/

License type: BSD-3-Clause

License details: “https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt”  on page 0

Sdl.MultiSelectComboBox
Version: 1.0.77

Vendor: RWS

Copyright: Copyright © RWS

License type: Apache 2.0

License details: “https://github.com/RWS/Multiselect-ComboBox/blob/master/LICENSE” 
on page 0
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Sharpcompress
Version: 0.36.0

Vendor: Adam Hathcock

Copyright: Copyright (c) 2014 Adam Hathcock

License type: MIT

License details:
“https://github.com/adamhathcock/sharpcompress/blob/0.36.0/LICENSE.txt”  on page 0

SharpZipLib
Version: 1.4.1.0

Vendor: ICSharpCode

Copyright: Copyright © 2000-2018 SharpZipLib Contributors

License type: MIT

License details: “https://github.com/icsharpcode/SharpZipLib/blob/v1.4.1/LICENSE.txt” 
on page 0

SimpleInjector
Version: 5.4.4

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: “https://github.com/simpleinjector/SimpleInjector/blob/v5.4.4/LICENSE” 
on page 0

SmartThreadPool
Version: 2.3.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: “https://github.com/amibar/SmartThreadPool/blob/v2.3.0/LICENSE”  on
page 0

System.Buffers
Version: 4.5.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0
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System.Collections.Immutable
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.IdentityModel.Tokens.Jwt
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/7.4.1/LICENSE.txt”
 on page 0

System.IO.Abstractions
Version: 4.2.17

Vendor: Tatham Oddie

Copyright: Copyright © Tatham Oddie 2010

License type: MIT

License details:
“https://github.com/System-IO-Abstractions/System.IO.Abstractions/blob/main/LICENSE”
 on page 0

System.IO.Pipelines
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Memory
Version: 4.5.5

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0
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System.Net.Http
Version: 4.3.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en-us/dotnet_library_license.htm”  on page
0

System.Numerics.Vectors
Version: 4.5.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0

System.Reactive
Version: 6.0.0

Vendor: .NET Foundation and Contributors

Copyright: Copyright (c) .NET Foundation and Contributors.

License type: MIT

License details: “https://github.com/dotnet/reactive/blob/rxnet-v6.0.0/LICENSE”  on page
0

System.Reflection.Metadata
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright:

License type:

License details: “https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT”  on page 0

System.Reflection.TypeExtensions
Version: 4.7.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

System.Runtime.CompilerServices.Unsafe
Version: 6.0.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

System.Text.Encoding.CodePages
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Encodings.Web
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Json
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.RateLimiting
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.Channels
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0
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System.Threading.Tasks.Extensions
Version: 4.5.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

YamlDotNet
Version: 8.1.0

Vendor: Antoine Aubry

Copyright: Copyright (c) 2008, 2009, 2010, 2011, 2012, 2013, 2014 Antoine Aubry and
contributors

License type: MIT

License details: “https://github.com/aaubry/YamlDotNet/blob/v8.1.0/LICENSE.txt”  on
page 0

ZstdSharp.Port
Version: 0.7.4

Vendor: oleg-st

Copyright: Copyright Oleg Stepanischev 2024

License type: MIT

License details: “https://github.com/oleg-st/ZstdSharp/blob/0.7.4/LICENSE”  on page 0
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